Edit Introduction

Version 7 Release 3
IBM Optim

Edit Introduction

Version 7 Release 3
# Contents

## Chapter 1. Overview
- Contents .......................................................... 1
- Sample Database Tables ................................. 1

## Chapter 2. Editing Data – Sample Scenario
- Getting Started ...................................................... 3
  - Access Group Box ........................................ 4
  - Initial Display Group Box .......................... 5
  - Mode Group Box ........................................ 6
- Using the Table Editor .......................................... 6
- Displaying a Specific Subset of Data .................... 7
- Editing Data ........................................................... 9
  - Overtake ....................................................... 10
  - Replace .......................................................... 10
  - Exclude .......................................................... 12
  - Repeat ........................................................... 13
  - Insert ............................................................ 17
  - LOB Data ....................................................... 18
- Undo Editing ........................................................ 20
  - Undo ............................................................ 20
  - Undo ............................................................ 22
  - Undo All ....................................................... 24

## Notices
- Trademarks ........................................................ 33

## Index
- ................................................................. 35
Chapter 1. Overview

The IBM® Optim™ solution includes the components Archive, Compare, Edit, and Move. This introduction provides information on how to use Edit.

This release runs in the Microsoft Windows environment and supports the IBM DB2®, Oracle, Sybase Adaptive Server Enterprise (ASE), Microsoft SQL Server, and IBM Informix® database management systems. Additional database management systems may be supported in future releases.

This information is intended to give you an overview of the functions and features included in Edit and the basic processing flow. Edit possesses a powerful Table Editor for browsing and editing related data that spans any number of tables.

Use the comprehensive Help facility in Edit at any time to obtain more information about a specific topic or function. You can select Help from the menu in most dialogs or right-click and select What's This from the shortcut menu to obtain context-specific help. Help is also available by pressing F1.

Contents

This introduction briefly describes the sample database distributed with Optim and provides an overview of the key functions for browsing and editing data in a sample scenario.

The sample scenario proceeds through the basics of selecting and editing data, using tables from the sample database.

Sample Database Tables

Optim is distributed with sample database tables. You can use these sample tables to test and demonstrate the facilities in Optim.

The sample database tables distributed with Optim, which correlate to the tables used in examples in this manual, are as follows:

• OPTIM_SALES
• OPTIM_CUSTOMERS
• OPTIM_ORDERS
• OPTIM_DETAILS
• OPTIM_ITEMS
• OPTIM_MALE_RATES
• OPTIM_FEMALE_RATES
• OPTIM_SHIP_TO
• OPTIM_SHIP_INSTR
• OPTIM_STATE_LOOKUP

Note: The tables used in examples in this manual do not contain the prefix “OPTIM_” in their names.

The relationships between pairs of tables in the sample database are shown in the following diagram. The arrows indicate the flow from parent to child.
In this diagram, the relationships between tables are represented by three-letter codes consisting of the letter "R", the first letter of the parent table, and the first letter of the child table.

The relationships between tables are as follows:
- OPTIM_SALES is a parent of OPTIM_CUSTOMERS (relationship RSC)
- OPTIM_CUSTOMERS is a parent of OPTIM_ORDERS (relationship RCO)
- OPTIM_ORDERS is a parent of OPTIM_DETAILS (relationship ROD)
- OPTIM_ITEMS is a parent of OPTIM_DETAILS (relationship RID)

The sample database includes four additional tables:
- OPTIM_CUSTOMERS2
- OPTIM_ORDERS2
- OPTIM_DETAILS2
- OPTIM_ITEMS2

These four tables are distributed empty and are related in the same way as the similarly named tables above. The empty tables are provided for demonstrating the facilities in Optim.

For a complete description of the sample database tables, see the *Installation and Configuration Guide*. 
Chapter 2. Editing Data – Sample Scenario

The following scenario directs you through the process of editing data using Edit.

Using relational data from the sample database, you retrieve data, select a subset of the data, use various editing capabilities, and join related data. As you follow these steps and use the Table Editor, you create an Edit Definition. An Edit Definition defines the set of data retrieved and displayed. It can be saved and reused, or shared with other users.

Note: The sample database tables distributed with Optim correlate to the tables used in examples in this scenario, although the table names in this scenario do not contain the prefix “OPTIM_”.

Getting Started

This section describes how to get started using Edit.

Select New from the File menu in the Optim main window, then select Edit from the Actions submenu. The Table Editor and the Editor Options dialog open at the same time, with the Editor Options dialog displayed on top.

Use the Editor Options dialog to specify parameters for the initial set of data to display in the Table Editor.
The Editor Options dialog contains three group boxes: Access, Initial Display, and Mode. For this scenario, enter the following parameters.

**Access Group Box**
The Access group box defines how the Table Editor fetches data.

You can select a table name or an Access Definition. An Access Definition can be used to define a set of related data, including the list of tables, selection criteria, and editor layout attributes. If you edit the same set of data repeatedly, an Access Definition can be used to save time by storing these specifications for reuse.

For this scenario, select Table in the Editor Options dialog, then click the browse button next to the Table box to display the Select a Table dialog.
Tables are organized in the Select a Table dialog by the fully qualified name. The fully qualified name of a table consists of: *dbalias.creatorid.tablename*.

*dbalias*

The DB Alias is the set of specifications that enables Edit to identify, locate, and access a particular database. In the left pane of the dialog, double-click the DB Alias that represents the database containing the sample database tables.

*creatorid*

Creator IDs are assigned when Edit is installed and configured. Determine the creator ID of the sample database from your system administrator.

**Note:** This qualifier may be referred to by a different name based on the DBMS (for example, schema or owner ID).

*tablename*

The table name to use for this scenario is CUSTOMERS.

The Select a Table dialog is divided into two areas. The DB Aliases are listed on the left, and the corresponding database table names appear on the right. The list is sorted alphabetically.

To display a list of table names for a particular DB Alias, double-click the DB Alias. You can also click the DB Alias and select **Refresh**.

Use any of the following methods to select the CUSTOMERS table name:

- Click the table name to highlight it, then click **Select**.
- Double-click the table name.
- Type the entire table name directly into the **Pattern** box and click **Select**.

**Initial Display Group Box**

In the Initial Display group box on the Editor Options dialog, you can specify which data to display in the Table Editor.

You can choose to include all rows, or you can assign selection criteria to define a specific subset of data.
For this scenario, select Data in the Initial Display box to include all rows.

**Mode Group Box**

In the Mode group box on the Editor Options dialog, you can specify an edit or browse mode for the data displayed in the Table Editor.

Select Edit as default in the Mode box because this scenario demonstrates the edit capabilities of Edit. Browse as default mode and Browse Only mode are used when data is to be browsed, but not edited.

After you make your selections in the Editor Options dialog, click **OK** to display the first 500 rows of data from the CUSTOMERS table in the Table Editor.

*Note:* The default fetch limit is set to 500. You can change the fetch limit, if necessary, to suit your requirements. Refer to the Common Elements Manual for more information about Personal Options. To cancel the retrieval of data, you can click **Cancel** in the Table Editor.

**Using the Table Editor**

This section describes how to use the Table Editor.

The Table Editor displays data from the selected table. The data displays in an edit window. An edit window contains toolbar buttons next to the table name in the heading. Toolbar buttons enable you to select display options and menu commands that pertain specifically to the corresponding table.

Column headings shown in bold type indicate primary key columns. In the example, CUST_ID is the primary key for the CUSTOMERS table. Use the scroll bars to display columns or rows that do not fit.
within the confines of the edit window. Click the scroll bar to display the number of columns or rows. A plus (+) sign after the number of rows indicates that the number of available rows exceeds the fetch limit.

**Displaying a Specific Subset of Data**

You can set selection criteria to limit the data in the Table Editor by displaying a specific subset of data.

Click the Options button on the edit window tool bar to display the edit window options menu. Select **Table Specifications** to display the submenu.

There are several ways to display a subset of the data from a table in the Table Editor. You can:
- Specify which columns to display and in which order.
- Define simple selection criteria or complex SQL Where clauses to limit which rows are fetched.
- Define sort criteria.

For this scenario, define a subset of data to limit the data to customers from the state of New Jersey only. Click **Selection Criteria** to display the Table Specifications dialog. The columns of the CUSTOMERS table display on the Selection Criteria tab of the Table Specifications dialog.

Click the grid row for the STATE column and type the statement =’NJ’ as shown.
Select **Close** from the **File** menu to fetch new data from the CUSTOMERS table.
The Table Editor displays the subset of rows from the CUSTOMERS table that contain NJ in the STATE column. To reset the Table Specifications, click the Options button on the edit window tool bar, select Reset, then select Selection Criteria from the submenu.

**Editing Data**

There are four levels of control for editing data in Edit. Each level of control provides specific ways to display, modify, insert, delete, and copy data.

**Menu Bar**

Select commands from the menu bar in the Table Editor to control all tables displayed in the Table Editor.

**Edit Window**

Select commands from the toolbar in an edit window to control the specific table displayed in the edit window.

**Grid Heading Shortcut Menu**

Right-click a grid heading of a column in the edit window grid to display the grid heading shortcut menu. Select commands from a grid heading shortcut menu to control the specific column in a table. The grid heading shortcut menu contains commands that enable you to find, exclude, include, sort, and hide rows based on the data contained in the column in which you right-clicked.

**Grid Column Shortcut Menu**

Right-click a row in the edit window grid to display the grid column shortcut menu. Select
commands from the grid column shortcut menu to control the specific row you right-clicked. Along with the normal cut, copy, and paste options, the grid column shortcut menu contains commands that enable you to clear, insert, repeat, and delete a row.

In this scenario, you edit data in several ways using commands from each of the four levels. By doing so, you sample some of the tools and functions available in Edit. You also prepare to understand the functions available to undo editing changes, discussed in the next section.

See the Edit User Manual for complete information about the Table Editor menu bar, the edit window toolbar, and the shortcut menus.

**Overtyping**

You can modify data by clicking a grid row and overtyping the data.

Click the column labeled ADDRESS in the first grid row of the edit window containing the CUSTOMERS table. Change the address to “1600 Pennsylvania Ave.”, then click outside the row to commit the change to the database.

You can overtype data in any column. If you change data in a primary key column that results in a violation of referential integrity rules, a warning message displays.

**Replace**

You can selectively replace data in a grid column.
For this scenario, use Replace to replace all occurrences of the ‘62700’ ZIP code with ‘99999’. Right-click in the heading of the ZIP column of the CUSTOMERS table. Select Replace on the grid heading shortcut menu to display the Replace dialog.

Type 62700 in the Find what box and type 99999 in the Replace with box. Select the Wrap check box in the Direction group box. You can find each occurrence of the ZIP code and selectively replace it by clicking Find Next, then Replace. Click Replace All to replace all occurrences.
The Status bar at the bottom of the Replace dialog indicates the number of replacements performed. Click Close to return to the Table Editor.

**Exclude**

You can selectively exclude data in an edit window.

For this scenario, use Exclude to hide the rows with the 99999 ZIP code. Right-click in the heading of the ZIP column. Select Exclude from the grid heading shortcut menu to display the Exclude dialog. Type 99999 in the Find what box on the Exclude dialog. Select the Wrap check box in the Direction group box.

Click Exclude All to hide all rows with the ZIP code 99999 from view. The Status bar shows the number of rows excluded. Click Close to return to the Table Editor.
A bold line separates rows before and after excluded rows. Position the pointer on the bold line to display the number of excluded rows represented by the line.

To show excluded rows, right click in the row before the bold line and select **Show Next** or **Show All** from the grid column shortcut menu.

**Repeat**

You can copy and repeat a row in the edit window using the grid column shortcut menu.

For this scenario, click the grid row of the CUSTOMERS table containing the address “1600 Pennsylvania Ave.” Right-click and select **Repeat** from the grid column shortcut menu.
The row containing the “1600 Pennsylvania Ave.” address is repeated.

Since the repeated row does not have a unique primary key, the status column of the row indicates that the row has an error. Additionally, an error message displays in the message bar.
To resolve the error, type a unique value in the primary key column.

Type “99999” in the CUST_ID column. Click outside the row to commit the change.
Modify the other columns of the repeated row by overtyping the data in the row, as follows:

- Overtype the name of the customer in the CUSTNAME column of the inserted row with the name “XYZ Video.” Press the Tab key to move the pointer to the ADDRESS column. The status of the row changes to Pending (Upd).

- Overtype the address with a new address, “123 Main St.,” then press Tab to move the pointer to the CITY column.

- Overtype the name of the city with a new name, such as “Anytown.” Click outside the row to commit the changes to the database.

The status of the row changes from to Pending (Upd) to Updated.
Insert
You can insert a new row in the edit window.

For this scenario, click the grid row of the CUSTOMERS table containing the value “00101” in the CUST_ID column. Right-click and select Insert from the grid column shortcut menu.

Type the unique primary key value “99998” in the CUST_ID column of the newly inserted row.

Each time you edit a row and commit the change to the database, Edit tracks and records the change as an Undo Level. To set up the demonstration of the undo capability of Edit in the next section, enter data in the new row one column at a time. Commit the change to each column by clicking outside the row after each change.

Edit the following columns:
• Type “Movie Time” in the CUSTNAME column.
• Type “3 High St.” in the ADDRESS column.
• Type “Anytown” in the CITY column.
• Type “NJ” in the STATE column.

Note: For this scenario, it is not necessary for you to enter data in the other columns in the new row. Some of the columns have data entered by default. For example, a question mark character is entered by default in columns that can be NULL. For complete information about default values, see the Edit User Manual.
Each time you click outside the row, the change to the row is committed to the database and the status of the row is **Updated**.

**LOB Data**

Large Object (LOB) columns are displayed in Native or Non-Native mode.

You can click the Options button in the edit window toolbar and select **Table Specifications, Columns** from the **Options** menu to switch between Native and Non-Native mode.

For columns processed in Non-Native mode, LOB data displays as normal table data, unless the size of the LOB exceeds the **Maximum Non-Native LOB Length** limitation, set in Personal Options. (Refer to the **Common Elements Manual** for more information about Personal Options.) If the size exceeds the maximum, the LOB appears truncated, and the grid cell is protected and cross-hatched, as in the following example.
For columns processed in Native LOB mode, a set of three icons is displayed.

![Image of table editor with LOB columns]

The following options are available for LOB columns processed in Native LOB mode:

- Click the icon to edit the LOB data using the application associated with the LOB. When editing LOB data, you cannot edit other data in the Table Editor. If an application association has not been established for the LOB data, you are prompted to create one.

- Click the icon to browse the LOB in character mode.

- Click the icon to browse the LOB in hex mode.

To create LOB column associations, click the Options button in the edit window tool bar and select Table Specifications, Columns to display the Columns tab of the Table Specifications dialog.

![Image of Table Specifications dialog]

Chapter 2. Editing Data – Sample Scenario
Use the **Association** column on the Columns dialog to associate a LOB column with the application required to view or edit the LOB data (for example, Microsoft Word, Microsoft NotePad, Microsoft Paint, etc.), in one of two ways:

- Enter a file name extension for the type of LOB (for example, type the extension `.doc` to associate a LOB Word document with Microsoft Word).

  **OR**

- Use the drop-down list to select a column name to reference. The first three characters of data in the corresponding row of the referenced column are used as the file name extension for the associated LOB column.

**Note:** When you attempt to edit LOB data for which an application association has not been established, you are prompted to create one.

When you attempt to edit LOB data associated with an application that is inaccessible from the workstation, Windows 2000 displays the Open with... dialog to enable you to select an accessible application. (Older versions of Windows may display an error message. You can manually assign an accessible application to use by selecting **Options, File Types** from the Windows **View** menu.)

---

**Undo Editing**

Edit enables you to selectively restore data to a prior commit point using various Undo commands.

You can undo changes to the current fetch set in each table in the Table Editor. Depending on the specific Undo command you use, you can undo changes to a row, to a table, or to all of the tables.

**Note:** You cannot undo changes made to LOB data.

Each time you commit a change to a row, Edit records an Undo Level. You can back out changes you make to a row up to the number of Undo Levels. The default number of Undo Levels is 5 per row, and the maximum number per row is 20.

You specify the number of Undo Levels on the Specify Edit Preferences dialog. See “**Setting Preferences**” on page 28.

---

**Undo**

The Undo command on the row shortcut menu backs out changes made to a row, one change at a time.

Click the grid row of the CUSTOMERS table containing the value “99998” in the CUST_ID column. Then right-click to display the row shortcut menu.
In this example, data was entered column by column and committed to the database after each entry. Select **Undo** to undo the last entry made, which was the entry of NJ in the STATE column.
The city, address, customer name, and customer ID number you entered can also be undone, in the reverse order of entry, by selecting **Undo** repeatedly.

**Undo...**

You can also select the version of a row within the fetch set to restore, up to the number of Undo Levels specified.

Click the grid row of the CUSTOMERS table containing the value “99998” in the CUST_ID column. Right-click to display the row shortcut menu. Select **Undo...** from the row shortcut menu.

The Undo Row List dialog displays each committed version of the row, to a maximum equal to the number of Undo Levels.
Select the version of the row that contains the CUST_ID value only. Click OK to restore that version of the row in the Table Editor.

![Table Editor](image-url)
Undo All
You can select **Undo All** from the row shortcut menu to back out all changes to a row, up to the number of Undo Levels.

Click the grid row of the CUSTOMERS table containing the value “99998” in the CUST_ID column.
Right-click to display the row shortcut menu.

Select **Undo All** from the row shortcut menu. All of the changes made to that row, including the insertion of the row, are undone.

---

**Edit Window Toolbar Undo Button**
You can use the Undo button ![Undo Button](image) on the edit window tool bar to undo changes made to all rows in the table in the edit window.

Edit backs out all changes to rows in the current fetch set, up to the number of Undo Levels per row.

**Edit Window Options Menu Undo Commands**
Click the Options button ![Options Button](image) on the edit window tool bar to display the edit window options menu.

You can use the following Undo commands on the edit window Options menu:

**Undo Last**
Select **Undo Last** to undo the last change made to a row in the current fetch set for the table.
Undo Errors
Select **Undo Errors** to undo changes that result in error conditions to any rows in the current fetch set for the table.

Table Editor Tools Menu Undo Commands
You can use the Undo commands in the Table Editor **Tools** menu.

Click the **Tools** menu in the Table Editor to select from the following Undo commands:

**Undo All**
Select **Undo All** to undo changes to all rows in all tables in the Table Editor. Edit backs out changes to rows in the current fetch set for each table, up to the number of Undo Levels per row.

**Undo Errors**
Select **Undo Errors** to undo changes that result in error conditions to any rows in the current fetch set for the table in the current fetch set for each table.

Displaying and Editing Related Data
You can browse and edit data in related tables with the Table Editor. The Join command enables you to select a table or several tables.

A relationship must exist between the table in the Table Editor and the table you select to join. If the tables are not related, you are prompted to create a relationship. If more than one relationship exists between the tables, a dialog displays to enable you to specify the relationship to use. Related data from the joined table displays in a new edit window.

Click the Join button in the edit window toolbar, or right-click in a row and select **Join** from the row shortcut menu to display the Select Table(s) dialog.
The Find Tables Related to Table check box is already selected when the Select Table(s) dialog is displayed. Therefore, the list is populated with the names of tables related to the table you are joining to in the Table Editor.

You can change the qualifier in the Enter pattern for Table box to display tables from any database to which you have access. Select a table from the list of table names. A relationship between the tables is required. See the Edit User Manual or the Common Elements Manual for detailed information about using the Select Table(s) dialog.

Join ORDERS Table
In the sample database, the ORDERS table is related to the CUSTOMERS table, so you must create a relationship between them if one does not exist.

For this scenario, double-click the ORDERS table in the Select Table(s) dialog. If a relationship does not exist between the table you select and the table in the Table Editor, you are prompted to create a relationship.

The related rows from the ORDERS table display in a separate edit window in the Table Editor.

Join Arrow
The first grid column in any edit window contains the Join arrow. The Join arrow indicates the row for which related data is displayed in joined tables.

You can move the Join arrow by clicking another row in the Join arrow column or by using the arrow keys on the keyboard.
For this scenario, the Join arrow in the CUSTOMERS table indicates the row containing the value “00172” in the CUST_ID column. The ORDERS table displays the rows related to that CUSTOMERS row. When you move the Join arrow to a different row in the CUSTOMERS table, the corresponding related rows are fetched and displayed in the ORDERS table.

**Multi-way Joining**
From any table in the Table Editor, you can join to more than one table. When you join more than one table to a single table, the joined tables share the same edit window, though only one table is shown at a time.

For this scenario, join another related table to the CUSTOMERS table. In the sample database, the SALES table is related to the CUSTOMERS table. Click the Join button in the toolbar in the CUSTOMERS table edit window. Double-click the name of the SALES table in the Select Table(s) dialog.

The SALES table displays and shares the edit window with the ORDERS table. Click the down arrow in the drop-down box that contains the name of the SALES table. The ORDERS table is listed in the box with the SALES table. You can select the table to display in the edit window by clicking on the table name.

You can configure Edit to automatically display the table that has at least one related row when you move the Join arrow. This “Auto Switch” option is useful when there are only related rows in one subordinate table for each parent row.

For additional information on joining multiple tables, refer to the Edit User Manual or the Common Elements Manual.
**Indent**

You can use the Indent function to view the list of tables in the Table Editor.

Select **Indent** from the **Tools** menu.

![Indented Table Display](image)

The Indented Table Display dialog displays the list of tables in the Table Editor. The list is indented to indicate the relationships between the tables in the Table Editor. Bold type indicates tables that are currently displayed in each edit window. You can double-click a table name to switch the table in an edit window.

**Unjoin**

To unjoin a table in an edit window, click the **Unjoin** button in the edit window tool bar. When you unjoin a table in an edit window, all tables joined to that table are also unjoined.

To unjoin all subordinate tables and close an edit window, click the **Unjoin All** button.

**Setting Preferences**

You can specify the way data displays in the Table Editor using several options in Edit.

Default settings for the Table Editor are specified in Personal Options. Refer to the *Common Elements Manual* for more information on Personal Options.

You can temporarily override the settings in Personal Options from the Table Editor using the Specify Edit Preferences dialog.
Specify Edit Preferences Dialog
The Specify Edit Preferences dialog contains check boxes and spin boxes that change the way data displays according to your specifications.

Select Preferences from the Tools menu to display the Specify Edit Preferences dialog.

![Specify Edit Preferences Dialog](image)

For complete information about the Specify Edit Preferences dialog, see the Edit User Manual.

Manipulating the Display
In addition to setting preferences for the Table Editor, you can manipulate the way columns and rows display in an edit window using toolbar buttons and shortcut menu commands.

Lock Columns
You can lock the position of a column to continue to display the column as you scroll data in the edit window horizontally.

Right-click in the heading of the CUSTNAME column in the CUSTOMERS table and select Lock from the shortcut menu. The CUSTNAME column repositions to the left of the display and locks in place as you scroll horizontally.

To unlock the column, right-click in the heading of the CUSTNAME column and select Unlock from the shortcut menu. The column unlocks, but remains in position to the left of the display. To reposition the columns to the original order, right-click and select Reset Grid Attributes from the shortcut menu.

Hide Columns
You can exclude columns from the display in the edit window to view fewer columns.
Right-click in the heading of the YTD_SALES column in the CUSTOMERS table and select Hide from the shortcut menu. The YTD_SALES column is hidden from view. You can also hide a column by dragging the right boundary of the column in the heading to the left boundary of the column.

To view hidden columns, right-click and select Unhide All from the grid heading shortcut menu.

**Sort**

You can sort the rows of data in a table before you edit.

Right-click in the heading of the CUST_ID column in the CUSTOMERS table and select Sort from the shortcut menu. Select Ascending or Descending to sort the rows numerically.

**Printing**

You can print several types of information.

From the Table Editor, you can print the following reports:

**Edit Definition Report**

Summarizes all the qualifiers, table names, and corresponding specifications that comprise the Edit Definition.

In the Table Editor, select Print from the File menu and select Definition from the submenu.

**Data from All Tables**

Includes all rows from all tables joined and displayed in the Table Editor.

In the Table Editor, select Print from the File menu and select Data and All from the submenus.

**Data from Selected Rows**

Includes all rows you selected from all tables joined in the Table Editor.

In the Table Editor, drag the pointer to select contiguous rows you want to print in each table. Select Print from the File menu and select Data and Selected from the submenus.

**Data from a Selected Table**

Includes all rows from a selected table in the Table Editor.

In the Table Editor, right-click in the grid heading in a selected table. Select Print from the shortcut menu.

**Saving**

When you close the Table Editor, you are prompted to save an Edit Definition and an Access Definition.

The Edit Definition contains an Access Definition and all of the parameters provided while using the Table Editor, including joined tables and editing and browsing specifications. An Edit Definition allows you to open the Table Editor without having to re-list tables, enter preferences, display options, and joined tables. You can also share the Edit Definition with other users.

Since an Edit Definition contains an Access Definition, you are also prompted to name and save the Access Definition. If you chose not to save the Access Definition, an embedded copy remains as part of the Edit Definition.

An Access Definition defines the set of tables and selection criteria that you specified in the Table Editor. You can reuse the Access Definition to specify the same set of data at a later time, use the Access Definition with another Optim component, and share the Access Definition with other users.

See the Common Elements Manual for detailed information about saving definitions.
Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing 2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:
If you are viewing this information softcopy, the photographs and color illustrations may not appear.

**Trademarks**

IBM, DB2, Informix, Optim, the IBM logo, and ibm.com® are trademarks or registered trademarks of International Business Machines Corporation in the United States, other countries, or both. If these and other IBM trademarked terms are marked on their first occurrence in this information with a trademark symbol (® or ™), these symbols indicate U.S. registered or common law trademarks owned by IBM at the time this information was published. Such trademarks may also be registered or common law trademarks in other countries. A current list of IBM trademarks is available on the Web at “Copyright and trademark information” at www.ibm.com/legal/copytrade.shtml.

Microsoft, Windows, and Windows NT are trademarks of Microsoft Corporation in the United States, other countries, or both.

Other company, product, or service names may be trademarks or service marks of others.
Index

A
Access Definition 30
Auto Switch 27

C
Creator ID 5

D
DB Alias 5
Direction 11

E
Edit Definition 30
Edit Overview 1
Edit Preferences 20
Edit Window 6
toolbar 9
Editing Related Data
indent 28
join 25
join arrow 26
join ORDERS table 26
multi-way joining 27
unjoin 28
Editor Options dialog 4
access 4
fetch limit 6
initial display 5
mode 6
Environment 1
Exclude 12
Exclude All 12

F
Fetch Limit 6
Find Next 11
Find What 11

G
Grid Column Shortcut Menu 9
Grid Heading Shortcut Menu 9

H
Hide Columns 30

I
Indent 28
Indented Table Display dialog 28
Insert 17

J
Join 25
more than one table 27
Join Arrow 26
Join Button 25
Join ORDERS Table 26

L
LOB columns 18
Lock Columns 29

M
Manipulating the Display 29
Menu Bar 9
Multi-way Joining 27

O
Options Button 7
Overtyp 10
Overview 1

P
Pending 16
Preferences 28
Primary Key 15
Printing 30

R
Refresh 5
Repeat 13
Replace 11
Replace All 11
Reset 9
grid attributes 29

S
Sample Database 1
Sample Scenario 3
Saving 30
Scroll Bar 6
Select a Table dialog 4
Selection Criteria 7
Setting Preferences 28
Show All 13
Show Next 13
Sort Rows 30
Specify Edit Preferences dialog 28, 29

T
Table Editor 3, 6
edit window 6
Table Name
fully-qualified 5
Table Specifications 7

U
Undo 20
all 24
button 24
errors 25
last 25
Row List dialog 22
Unhide 30
Unjoin 28
Unlock 29

W
Wrap 11